
Sida

HANDHAVANDE

INNEHÅLL

1 Allmänt ..........................................................................  3

2 Ladda ner malldokument ............................................  4

3 Malldokument - Inlaga .................................................  5
3.1 Rotelementet datamodul .............................................  5
3.2 Beskrivningsnivåer ......................................................  8
3.3 Bilder ...........................................................................  9
3.4 Tabeller .....................................................................  11
3.5 Listor .........................................................................  16
3.6 Uppmärksamhetstexter .............................................  17
3.7 Hänvisningar .............................................................  18
3.8 Fotnoter ....................................................................  20
3.9 Framhävd och annan speciell text ............................  20
3.10 Genererade listor ......................................................  21

4 Malldokument - Titelblad ...........................................  22
4.1 Ändra flikantal ...........................................................  22

5 Malldokument - Omslag ............................................  23

6 Malldokument - Försättssida ....................................  24

7 Sekretessmärkning ....................................................  25
7.1 Placera/ändra sekretessmärkning ............................  25
7.2 Exemplarnumrering ..................................................  25

8 Uppdatera dokumentet enligt ny mall ......................  26
 1



1  Allmänt
Detta dokument innehåller anvisningar för handhavande av mallpaketet FMV 
Produktionsmiljö 3 Bokpublikationer. 
Mallarna i paketet är i formatet FrameMaker. Handhavande som är specifikt 
för mallarna tas upp i detta dokument.
Användare av mallpaketet förutsätts ha grundläggande kunskaper i:
• Arbete med strukturerade dokument i FrameMaker 
• Regelverk FMV Materielpublikationer
Hanteringen av malldokumenten skiljer sig beroende på vilken typ av malldo-
kument det handlar om.

OBS
Arbete med dokument av typen inlaga kräver att det strukturerade 
gränssnittet är är påslaget i FrameMaker för att inte förstöra doku-
menten.

Mallarna är vanliga FrameMaker dokument utan någon struktur från någon 
EDD. Strukturen är ej nödvändig för att kunna skapa önskat utseende för 
skärmbildspresentation, ej heller för framtidssäkring då de strukturerade doku-
menten kan innehålla tillräcklig information för detta.
Till en publikation kan följande läggas till:
• Genererade listor som innehållsförteckning, index, etc
• Titelblad
• Försättsblad
• Omslag
Innehållsförteckning och index kan genereras direkt från dokumenten med ett 
fungerande utseende.
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2  Ladda ner malldokument
På FMV's logistikportal finna alla mallar som FMV tillhandahåller. Malldoku-
menten finns tillgängliga på logistikportalen i formatet MIF, ett format som 
kan läsas av alla versioner av FrameMaker. 
Använd FrameMaker version 10 eller senare för att inte förlora några egenska-
per i mallarna.
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3  Malldokument - Inlaga
Inlagan är ett strukturerat dokument enligt Enkeldok DTD och måste därför 
hanteras i FrameMaker med det strukturerade gränssnittet påslaget för att inte 
förstöra dokumentet. flera funktioner i mallen utnyttjar strukturen och skulle 
inte fungera utan denna.
Anvisningarna nedan tar upp de delar av EnkelDok DTD som används speci-
fikt i mallarna vilket innebär att det finns element och attribut som lämnas utan 
kommentarer.

3.1  Rotelementet datamodul
Elementet Datamodul är inlagans s k rotelement. Detta element omsluter 
hela inlagans innehåll och innehåller de attributvärden som gäller hela doku-
mentet.
Följande element kan användas under rotelementet Datamodul:
Tabell

Ordningen för elementen under rotelementet är fast (enligt listan ovan). Däre-
mot är det frivilligt att använda sig av dom. 
Elementet Datamodul innehåller ett stort antal attribut för placering av olika ty-
per av information i dokumentet. En del av dessa används för att bestämma ut-
seendet på dokumentet medan andra ger plats för information om dokumentet.
Vissa av attributen hämtas av mallen till sidhuvud och sidfot. Dessa attribut har 
i regel fyllts med ett värde så att en användare lättare kan se var denna infor-
mation syns i dokumentet.

Titel Dokumentets titel

Ih, Ihref Används för att kunna länka in en 
innehållsförteckning i dokumentet.

Varn, Obs, Anm Element för uppmärksamhetstexter. För mer 
information om dessa se 3.6 Uppmärksamhetstexter 
sida 17.

Niv1 Avsnitt i dokumentet på den översta 
beskrivningsnivån, se även element Avsnitt nedan.

Avsnitt Avsnitt i dokumentet som inte är bundet till vilken 
nivå avsnittet är placerat. Kan användas istället för 
elementen Niv1-5.
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3.1.1  Dokumentets format
Utseendet på dokumentets innehåll styrs av flera attribut i rotelementet Data-
modul. På detta sätt kan utseendet lätt ändras efter behov genom att byta värde 
på ett attribut.
Ett värde behöver normalt vara satt i dokumentet för korrekt funktionalitet i do-
kumentet.
TabellTabell 1. Attribut för styrning av funktionalitet och layout

Attribut Värde(n) Beskrivning

Format A4ls34n 
A4ls2n 
A4hs34n 
A4hs2n 
A5ls1n 
A5hs1n 
A3ls134n

Bestämmer utformningen på hela 
dokumentet. Finns för varje typ av 
strukturerat malldokument.
Detta attribut används för att skilja mellan de 
olika dokumenttyperna då dessa använder 
samma EDD i produktionsmiljön.
För mer information om attributet Format 
se 7 Uppdatera dokumentet till ny mall sida 
25.

Nivnum Ingen 
R03 
R13 
R05 
R15 
R15s1

Val av rubrik och styckenumrering:
R<start><antal>[S]
<start>: Startsiffra på nivå 1
<antal>: Antal rubriknivåer
R = rubriknumrering
S = styckenumrering

Nivplac N1tf25f 
N15f 
N13f45c 
N1tf23f45c 
N1tf25c 
N15c 
N1rtf25f

Bestämmer placeringen av rubriker för olika 
beskrivningsnivåer. 
Siffrorna hänvisar till rubriknivåerna.
r: Höger (right)
t: Överst i textram eller kolumn 
f: i textram(frame)
c: i kolumn (column)

Sprak Swe 
Eng

Val av språk i dokumentet för styrning av 
avstavning och genererade texter i 
dokumentet.
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3.1.2  Information om dokument och objekt
Attributen i tabellerna nedan används för information om dokumentet och det 
eller de objekt som dokumentet beskriver. Det är normalt valfritt att använda 
dessa attribut men vissa av dom behöver ett värde ifall värdet ska synas i t ex 
sidhuvudet.
TabellTabell 2. Attribut för information om dokumentet/publikationen

Andr-
mark

Inga 
alla

Bestämmer om ändringsmarkering ska visas 
eller ej

Attribut Värde(n) Beskrivning

Attribut Värde Beskrivning

Doktitel <text> Dokumentets/flikens fullständiga titel

Pubtitel <text> Publikationens fullständiga titel

Faststdat <text> Fastställelsedatum

Datum <text> Datum för utgivning av dokument/
publikation

Pubtyp <text> Typ av publikation, t. ex. MVIF, 
Vårdsystem 80

Fben <text> Publikationens förrådsbenämning, t. ex. 
ROSKSCH STRV 203

Fbet <text> Publikationens förrådsbeteckning, t. ex. 
M7782-998677

Pubfastst <text> Publikationsbeslutsnummer

Ansv <text> Ansvarig för dokumentet, t. ex. FMV 

Sakhandl <text> Sakhandläggare

Teknuhs <text> Tekniskt underhållsstöd

Pubdel <text> Del (pärm) av en publikation, t. ex. Del 1, 
Del 2. attributet lämnas tomt om 
publikationen endast består av en del

Pubflik <text> Flik i publikationen, t. ex. Flik 1, Flik 2, 
attributet lämnas tomt om publikationen 
inte är uppdelad i flikar
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3.1.3  Information om objekt
TabellTabell 3. Attribut för information om det beskrivna objektet

3.2  Beskrivningsnivåer
För uppdelning i beskrivningsnivåer används elementen Niv1, Niv2, Niv3, 
Niv4 och Niv5 eller enbart elementet Avsnitt.
Niv2 kan placeras i Niv1, Niv3 kan placeras i Niv2, etc, medan elementet 
Avsnitt kan nästlas obegränsat antal gånger. I mallarna finns endast stöd för 5 
nivåer oavsett vilket avsnittselement som används.
Varje beskrivningsnivå kan innehålla följande:

Lev <text> Leverantör av publikationen

Distr <text> Varifrån ytterligare exemplar kan beställas

Levref <text> Plats för referenser för det producerande 
företaget: Företagsnamn, filnamn etc.

Utgbet <text> Revisionsnivå.

Arbutgbet <text> Revisionsstatus

Sekretess O|H|Kh Sekretessgrad: Ej hemlig, Hemlig eller 
Klassificerat hemlig

Andrenl <text> Avsett för användarens uppföljning av 
ändringar

Upphaver <text> Dokument som upphävs av detta dokument 
(ett eller flera)

Attribut Värde Beskrivning

Attribut Värde Beskrivning

Uhobj <text> Underhållsobjekt

Kod <text> Kod, MIMI-kod

Matrobj <text> Materielobjekt

Matrgrp <text> Materielgrupp

Matrugrp <text> Materiel undergrupp

Lopnr <text> Löpnummer
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Tabell

Elementet Rubrik måste placeras först på en specifik beskrivningsnivå. Ele-
ment för en lägre beskrivningsnivå, Niv2, Niv3, etc. måste placeras sist. De öv-
riga elementen kan läggas in däremellan i godtycklig ordning och i valfritt 
antal.

3.3  Bilder
För hantering av bilder används följande element:
Tabell

Elementet Bild kan innehålla elementen Bild-data (alt. Bild-plats), 
Bild-poslista samt Bild-rubrik. Elementen, en av varje, kan place-
ras i valfri ordning.
Elementet Bild-data kan placeras direkt under Bild eller omslutet av ele-
mentet Bild-plats som i sin tur ligger direkt under Bild. 

Rubrik avsnittets titel

Varn, Obs, Anm element för uppmärksamhetstexter. För mer 
information om dessa se 3.6 Uppmärksamhetstexter.

Text den egentliga brödtexten

Lista-num numrerad lista, se 3.5 Listor

Lista-punkt en punkt-lista, se 3.5 Listor

Table för att skapa en tabell, se 3.4 Tabeller

Bild för placering av en bild i dokumentet, se 3.3 Bilder

Sidbryt gör det möjligt att lägga in en sidbrytning i 
dokumentet.

Nivx innehåller ett avsnitt i dokumentet på nästa 
beskrivningsnivån (x=2, 3, 4 eller 5).

Bild rotelementet för en bild

Bild-data bildelement som innehåller en referens till den bild 
som är länkad in i dokumentet

Bild-plats ett valfritt extra element för flexiblare placering av 
bildelementet Bild-data

Bild-poslista för beskrivning av utmärkta positioner i bild. se 
3.3.3 Lägga till positionsbeskrivning

Bild-rubrik plats för bildtitel
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Elementet Bild-data kan även placeras direkt i olika styckebaserade element 
för att på så sätt ge möjlighet att lägga in ett bildobjekt direkt på textraden.

3.3.1  Inlänkning av bild
En bild kan sättas in nästan överallt i dokumentet, även i tabell. Vid insättning-
en utnyttjas den inbyggda funktionen för import av bild som aktiveras vid in-
sättning av elementet Bild.
1 Placera insättningspunkten på giltig plats för bild.
2 Sätt in elementet Bild.

Dialogrutan Import File visas.
3 Välj bildfil som ska länkas in.
4 Sätt in elementet Bild-poslista om så önskas.
5 Sätt in elementet Bild-rubrik om så önskas.

OBS
Med nuvarande version av FrameMaker+SGML rekommenderas 
att bilder sparas i samma mapp som textdokumenten då 
FrameMaker+SGML ej ännu hanterar relativa sökvägar på ett bra 
sätt.

För mer information se:
• 3.3.2 Placering av bild sida 10. 
• 3.3.3 Lägga till positionsbeskrivning sida 11

3.3.2  Placering av bild
Bildens placering kan ändras i förhållande till den text den är kopplad till. I va-
let ingår att bestämma om elementet Bild-plats ska användas eller inte 
samt att sätta attributet Bredd under elementet Bild.
Produktionsmiljön stödjer även en del av funktionerna för kopplad ram som 
placering i texten, justering i sidled samt vertikalt avstånd i förhållande till pla-
cering i texten (gäller endast då bilden är placerad i marginalen).
1 Sätt in elementet Bild-data i elementet Bild-plats om så önskas

Detta gör det möjligt för en mer flexibel placering av bilden i texten.
2 Ställ in önskad placering, justering samt offset för kopplad ram.

Detta ställs in under Special > Anchored Frame... under huvudmenyn.
3 Sätt attributet Bredd under elementet Bild till önskat värde enligt tabel-

len nedan.
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TabellTabell 4. Attributet Bredd under elementet Bild

OBS
Använd originalstorlek på bilderna. 
Skalning av bilder stöds ej vid export till SGML. Skala därför inte 
om inlänkade bilder i FrameMaker+SGML.

3.3.3  Lägga till positionsbeskrivning
I de fall där utpekningar i en bild är gjord med siffror (poser) kan en lista med 
beskrivningar på dessa läggas till under elementet Bild.
Tabell

Bestämning av pos i elementet Bild-pos görs med attributet Pos.

3.4  Tabeller
Vid insättning och hantering av tabeller i FrameMaker+SGML, utnyttjas den 
inbyggda tabellfunktioner för detta. 
Elementstrukturen för Table är:
Table: (Title?, Tgroup, Tabnoter?)

De olika elementen används till följande:
Tabell

Attribut Värde Beskrivning

Bredd "Spalt" över alla kolumner

"Fullbredd" över hela satsytan

"Marginal" i marginal men inom satsytan

"Dubbel" används ej i produktionsmiljön

"Kolumn" i kolumn

Bild-poslista lista med beskrivningar på utmärkta poser i en bild

Bild-pos beskrivning på en pos

Table rotelementet för tabell

Title tabelltitel

Tgroup den egentliga tabellen

Entry markerar innehållet för varje cell i tabellen
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Det finns ytterligare element i en tabell som t.ex. Tbody, Row, etc. Dessa han-
teras dock automatiskt av FrameMaker+SGML.
Elementet Title är valfri. Elementet Tabnoter är en konstruktion för att 
kunna placera fotnoter under en tabell i tidigare versioner av DTD’n. I produk-
tionsmiljön används dock istället elementet Fotnot i och utanför tabeller för 
att skapa fotnoter. 
I tabellcellen (Entry) går det att skriva in text direkt. Om ett mer komplext 
innehåll ska föras in går det istället att använda elementen Text, List-
punkt, Lista-num samt Bild.
För mer information, se:
• 3.4.1 Insättning av tabell sida 12. 
• 3.4.3 Justering av text i celler sida 15. 
• 3.4.2 Placering av tabell sida 15.

3.4.1  Insättning av tabell
1 Placera insättningspunkten på giltig plats för tabell.
2 Sätt in elementet Table.
3 Sätt in en tabelltitel om en sådan önskas med elementet Title.
4 Sätt därefter in elementet Tgroup.

Dialogfönster Insert Table öppnas där val av antal rader och kolumner 
samt tabelltyp kan göras.

5 Sätt in lämpliga värden för tabellformat, antal kolumner, rader i tabellen, 
rader i tabellhuvud etc.
Ett valt tabellformat bestämmer endast om och var linjer ska finnas i tabel-
len samt linjetjocklekar.

TabellTabell 5. Tabellformat

Tabellformat Beskrivning

Tabell-enkel Enkelt utförande med endast horisontella linjer för 
att indikera en tabell

Tabell Normalt utförande på en tabell. Ram runtom och 
linje mellan varje kolumn

Tabell-kompakt Samma utförande som valet Tabell. Detta val 
användes i version 1.0 för att få mindre avstånd till 
tabellcellens kanter. Nu styrs detta av EDD’n
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6 Sätt attributet Tabstyle under elementet Table för att bestämma styck-
eutformningen i tabellcellen..
Med detta attribut bestäms fontstorlek, styckeavstånd samt avstånd till 
cellkanter i tabellcellen.

OBS
Värdet på attributet Tabstyle behöver inte nödvändigtvis överens-
stämma med det använda tabellformatet.

TabellTabell 6. Attributet Tabstyle under elementet Table

OBS
Använd de tabelltyper i dialogrutan Insert Table som benämns 
med versal-gemen text (ex. Tabell-kompakt). 
Tabelltyper med versal text (ex. TABELL-KOMPAKT) har lagts till 
p.g.a. att benämningar på tabelltyper hanteras fel i 

Text-kolumner Tabell utan ram och linjer, används där endast en 
uppdelning av texten i kolumner önskas.

Attribut Värde Beskrivning

Tabstyl
e

"Text- 
kolumner"

Ger samma storlek på det använda 
typsnittet som på den omgivande texten. 
Inget avstånd till vänster cellkant.

"Enkel" Samma utförande som för värdet 
Normal. Detta val användes i version 1.0 
för att passa till tabellformatet Tabell-
enkel. 

"Normal" Ger normalt ett typsnitt på -1 punkters 
storlek i förhållande till den omgivande 
texten.

"Kompakt" Ger en tabell med storlek på typsnitt på 
normalt -3 punkter mot den omgivande 
texten.
Avstånd till cellkanterna har också 
minskats.

Tabellformat Beskrivning
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FrameMaker+SGML vid import/export SGML.
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3.4.2  Placering av tabell
Tabellen kan placeras på olika sätt i texten. Med attributet Bredd går det att 
ta hänsyn till hur bred en tabell är, se tabellen nedan.
TabellTabell 7. Attributet Bredd under elementet Table

OBS
FrameMaker+SGML justerar själv automatiskt positionen av en ta-
bell i kolumn, spalt eller satsyta beroende på storleken av tabel-
len. Detta bör dock undvikas då tabelltiteln beroende på 
malldokument kan placeras fel.

OBS
FrameMaker+SGML stödjer ej användning av attributet "Orient" 
för att bestämma orientering av tabell på sidan. Om roterad tabell 
önskas, använd istället malldokument med liggande sida. 

3.4.3  Justering av text i celler
Text i tabellceller kan justeras i sida med attributet Align samt höjd med att-
ributet Valign under elementet Entry.
1 Markera den eller de celler i tabellen som ska ges en bestämd justering.
2 Välj Element > Edit attributes... i huvudmenyn.
3 Sätt önskat värde på attributet align eller Valign enligt tabellen nedan.

Attribut Värde Beskrivning

Bredd "Spalt" Tabell med titel är vänsterställd i text-
spalten

"Fullbredd" Tabell med titel är vänsterställd på 
satsytan

"Kolumn" Tabell med titel är placerad och centrerad 
i kolumn
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TabellTabell 8. Attributet Align och Valign under elementet Tabell

3.5  Listor
Vid hantering av listor används följande element:
Tabell

Typ av lista väljs genom att sätta in rotelementet Lista-punkt eller Lis-
ta-num. Varje lista består av en eller flera element Lista-elem. För att 
kunna skriva in text måste därefter Lista-text läggas in.
Det är möjligt att lägga lista i lista. Stöd med avseende på utseende finns för 
listor i två nivåer oavsett kombination.
I strukturen för en lista kan ytterligare element läggas till. Rotelementet för res-
pektive lista kan förutom Lista-elem även innehålla elementen Anm, Obs 
samt Varn, se 3.6 Uppmärksamhetstexter sida 17. Elementet Lista-elem 
tillåter dessutom elementet Bild, se 3.3 Bilder sida 9.

Attribut Värde Beskrivning

Align "Left" Vänster

"Right" Höger

"Center" Mitten

"Justify" Rak vänster- och högermarginal

"Char" Finns ej stöd för detta 

Valign "Top" Högst upp

"Middle" I mitten

"Bottom" Längst ner

Lista-punkt rotelement för punktlista som i huvudsak används 
för uppräkningar

Lista-num rotelement för numrerad lista som i huvudsak 
används vid instruktioner där momenten ska göras i 
en bestämd ordning

Lista-elem en del av lista med Lista-punkt eller Lista-
num som rotelement

Lista-text text i lista, ingår i Lista-elem
 15



3.6  Uppmärksamhetstexter
Uppmärksamhetstexter används när man vill göra användaren av informatio-
nen uppmärksam på viktig information. Det finns tre olika typer av uppmärk-
samhetstexter i produktionsmiljön:
• Anmärkning
• Observera
• Varning

3.6.1  Anmärkning
En anmärkning används för att uppmärksamma viktig information för fortsatta 
instruktioner. 
Vid insättning av en anmärkning används följande element:
Tabell

Vid insättning av elementen Anm, görs även en automatisk insättning av ele-
menten Anm-text. 
Förutom text-elementen går det även att sätta in punktlistor med elementet 
Lista-punkt, se 3.5 Listor.

3.6.2  Observera
Observera används när risk för skador på materiel föreligger.
Vid insättning av text av typ observera, används följande element:
Tabell

Vid insättning av elementet Obs, görs även en automatisk insättning av ele-
menten Obs-text. 
Förutom text-elementen går det även att sätta in punktlistor med elementet 
Lista-punkt, se 3.5 Listor sida 16.

3.6.3  Varning
En varning används när risk för personskador föreligger. 
Vid insättning av en varning används följande element:

Anm Rotelement för anmärkning

Anm-text plats för textinnehållet i en anmärkning

Obs Rotelementet för observera

Obs-text textinnehållet i observera
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Tabell

I FrameMaker+SGML används tabellfunktionen för att kunna rama in en var-
ning, dvs skapa en varningsruta. Detta har inneburit att de extra elementen 
Varn-body, Varn-row samt Varn-cell har lagts till i 
FrameMaker+SGML för att detta ska fungera. I SGML-format har däremot 
varning samma struktur som anmärkning och observera med elementen Varn 
samt Varn-text.
I varningsrutan, dvs i elementet Varn-cell går det också att lägga till en bild 
med elementet Bild-data. Denna bild består oftast av en symbol som t.ex. 
en varningstriangel. För att varningsrutan ska få ett riktigt utseende med en in-
lagd bild, måste bildelementet omslutas av elementet Bild-plats.

Insättning av en varning
En varning sätts in enligt följande:
1 Placera insättningspunkten på giltig plats för varningselementet.
2 Sätt in elementet Varn från elementkatalogen.

Dialogrutan Insert Table öppnas med tabellformatet Varningsruta marke-
rad samt med en rad, en kolumn och inget huvud eller fot.

3 Klicka på Insert.
4 Sätt in elementet Varn-text.

3.7  Hänvisningar
Hänvisningar eller korsreferenser som de också kallas, läggs in i dokumentet 
med hjälp av referens-element. I mallpaketet för FMV Bokpublikationer an-
vänds följande referens-element:
• Ref avsnitt
• Ref-bild
• Ref-tabell
• Ref-moment
Det förinställda formatet på respektive referens visar hela eller delar av det re-
fererade objektet. Om så önskas, kan referensformatet bytas till en variant med 
sidhänvisning.

Varn Rotelementet för varning

Varn-body tabellkroppen i varning

Varn-row en rad i tabellen (det finns bara en rad)

Varn-cell en tabellcell dvs varningsrutan

Varn-text text i varningsrutan
 17



Tabell

3.7.1  Refererade objekt
Detta avsnitt innehåller de refererade objekten.
Bild

Bild 1. Bildexempel
TabellTabell 9. Tabellexempel

Instruktion med elementet Lista-elem i Lista-num:
1 En första instruktion
2 En instruktion till

Referens-
element

Destination Referens Referens med sida

Ref-avsnitt Rubrik 3.7.1 
Refererade 
objekt

3.7.1 Refererade objekt 
sida 19

Ref-bild Bild-rubrik Bild 1 Bild 1 sida 19

Ref-tabell Title Tabell 9 Tabell 9 sida 19

Ref-moment Lista-elem 2 2 sida 19
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3.8  Fotnoter
En fotnot1 i den löpande texten läggs in med elementet Fotnot2. Om en fotnot 
önskas i en tabellcell, måste den placeras i elementet Text.
TabellTabell 10. Tabell med fotnoter

Text till fotnot som är placerad utanför tabell, placeras alltid längst ned på sam-
ma sida som fotnotens nummer medan text till fotnot i tabell, alltid placeras di-
rekt under tabellen.

3.9  Framhävd och annan speciell text
Text som ska framhävas märks med särskilda element. Produktionsmiljön om-
fattar följande element för utpekning:
Tabell

Elementen Z-upp och Z-ner samt Z-betoning tillåts överallt där text är 
tillåten. Markord måste placeras i elementet Text.
TabellTabell 11. Attributet Typ under elementet Markord

1. Kompletterande upplysning till ämnet med placering längst ned på sidan.
2. Element i EnkelDok DTD 

Kolumnrubrik

Text med en fotnota

a. Text i tabellens första fotnot

Text med en fotnotb

b. Text i tabellens andra fotnot

Z-betoning för markering av en del av texten

Z-upp gör texten upphöjd, t.ex. O2

Z-ner gör texten nedsänkt, t.ex. O2

Markord används för att märka ut ett eller flera ord av en viss 
typ, se tabellen nedan för tillgängliga val på dess 
attribut Typ

Attribut Värde Beskrivning

Typ "Systemtext
"

Används till t.ex filnamn, 
elementnamn
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3.10  Genererade listor
Vid skapande av genererade listor som innehållsförteckning, index, bildlistor, 
etc. används de inbyggda funktionerna för generering av listor i 
FrameMaker+SGML.
1 Välj File > Generate/Book...

Dialogrutan Generate/Book visas.
2 Markera önskad typ av lista/Index.

I produktionsmiljön finns stöd för:
• Innhållsförteckning (Table of Contents)
• Index (Standard Index)
• Bildlista (List of Figures)

3 Klicka på Generate...
En ny dialogruta visas där val kan göras av vilka element och paragrafer 
som ska tas med i den genererade listan. Detta är dock normalt redan för-
valt (lagrat i malldokumenten).

4 Klicka på Generate... igen.
Ett nytt dokument skapas med en lista på de element och paragrafer som 
har valts.

5 Om så önskas, byt utseende på listan m h a malldokument.
Tillgängliga malldokument för listor finns i huvuddokumentet under För-
sättssidor.

6 Komplettera i huvud och fot så att rätt information finns angiven.

"Paneltext" Används vid benämningar på 
manöverorgan och annan TEXT på 
materiel

Attribut Värde Beskrivning
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4  Malldokument - Titelblad
Ett titelblad innehåller information om publikationen som bladet ingår i. Ett ti-
telblad kan vara av två typer:
• för inbunden publikation, med eller utan innehållsförteckning
• för lösbladspublikation med flikregister
I alla mallar för titelblad skrivs texten in på mallsidan. Det har gjorts på detta 
sätt för att på ett enkelt sätt kunna generera flera numrerade exemplar av en 
hemlig publikation.
För information om hur hemliga dokument hanteras, se avsnitt 7 Sekre-
tessmärkning.

4.1  Ändra flikantal
Gör på följande sätt för att ändra antalet flikar på ett titelblad:
1 Gå över till mallsida
2 Dra ifrån respektive lägg till önskat antal rader i tabellen.
3 Markera hela tabellen.
4 Välj Table > Format > Row Format i huvudmenyn.
5 Skriv in ett värde på Minimum och Maximum under Height Limits så att 

tabellen fyller ut hela sidan på höjden (Sidans höjd / antal tabellrader).
Numreringen av flikarna kan varieras genom att styckeformaten Fliknum, 
Fliknum=0 eller Fliknum=man appliceras på numreringen.
 21



5  Malldokument - Omslag
Malldokument för omslag finns för framsida, rygg samt baksida. Malldoku-
menten innehåller inlänkade logotyper, sparade i Adobe Illustrator format EPS 
med TIFF skärmbildspresentation, för försvarsmakten respektive Försvarets 
materielverk.
I alla mallar för omslag skrivs texten in på mallsidan. Det har gjorts på detta 
sätt för att på ett enkelt sätt kunna generera flera numrerade exemplar av en 
hemlig publikation.
För information om hur hemliga dokument hanteras, se avsnitt 7 Sekre-
tessmärkning sida 25.
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6  Malldokument - Försättssida
Försättssidorna har ungefär samma utseende som motsvarande strukturerade 
dokument för lösblad. Däremot används inte struktur i dessa dokument utan de 
fungerar som vanliga FrameMaker dokument. För den funktionalitet som har 
krävts för dessa har det lagts till önskade styckeformat, teckenformat, tabellfor-
mat, etc.
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7  Sekretessmärkning
I alla mallar är det möjligt att lägga till en sekretessmärkning. Beroende på mall 
och placering ser den olika ut samt hanteras på lite olika sätt.
Bestämmelser för hantering av sekretessbelagd information finns beskrivet i 
15FMV11468-2:1 - Tjänsteföreskrift (TjF) avseende säkerhetsskydd och se-
kretess. 

7.1  Placera/ändra sekretessmärkning
Sekretessmärkning läggs in eller byts på mallsidorna "Master Pages" genom att 
byta styckeformat på avsedd plats.
TabellTabell 12. Val av sekretessmärkning med hjälp av styckeformat

Hanteringen ovan är framtagen för att lättare få sekretessmärkningen att hamna 
på rätt plats på respektive sida.
Den stora sekretessmärkning på titelblad och omslag, kräver även en modifie-
ring av märkningen vilket görs på referenssidorna där märkningarna är place-
rade.

7.2  Exemplarnumrering
På hemliga publikationer ska omslagen och titelblad förses med exemplarnum-
mer.
1 Placera insättningspunkten där exemplarnumret är placerat. 
2 Sätt styckeformetet till Exemplar
3 Tryck på ENTER. Varje gång ENTER trycks in räknas exemplarnumret 

upp.

Säkerhetsklass Sidhuvud höger Sidhuvud 
vänster

Titelblad, 
Omslag

Öppen Oppen Oppen Oppen

HEMLIG/
RESTRICTED

hemlig-Liten hemlig-Bred-R hemlig-R

HEMLIG/
CONFIDENTIAL

hemlig-Liten hemlig-Bred-C hemlig-C

HEMLIG/SECRET hemlig-Liten hemlig-Bred-S hemlig-S

HEMLIG/TOP 
SECRET

hemlig-Liten-TS hemlig-Bred-TS hemlig-TS
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8  Uppdatera dokumentet enligt ny mall
Ett dokument i FrameMaker kan ges ett nytt utseende genom att importera for-
mat och andra definitioner från ett annat dokument. Denna möjlighet används 
i mallpaketet för Bokpublikationer då ett dokument med inlaga eller försättssi-
da ska uppdateras till en nyare version av ett malldokument.

OBS
Omslag eller titelblad kan ej uppdateras genom import av format 
utan att förstöra inmatad text då texterna i dessa dokument är pla-
cerade på mallsidor.

1 Öppna båda dokumenten i FrameMaker.
2 Ställ markören i det dokument som ska uppdateras.
3 Importera format.

a Välj File > Import > Formats... i huvudmenyn
b Välj dokumentet som formaten ska hämtas ifrån.
c Kryssa i alla val under "Import and Update"
d Kryssa i "Other Format/Layout Overrides"
e Import

Om dokumentet är av typen inlaga och därmed ett strukturerat dokument, fort-
sätt med:
4 Importera elementdefinitionerna från malldokumentet.

a Välj File > Import > Element Definitions... i huvudmenyn
b Välj dokumentet som definitionerna ska hämtas ifrån.
c Kryssa i "Format Rule Overrides"
d Import

Om malltyp ändras vid uppdatering av inlaga, fortsätt med:
5 Byt värdet på attributet Format i rotelementet Datamodul till samma som 

malldokumentet använder, se tabellen nedan.
TabellTabell 13. Attributet Format under rotelementet Datamodul

Attribut Värde Beskrivning

Format A4ls34n A4 lösblad 3/4-spalt

A4ls2n A4 lösblad 2-spalt
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A4hs34n A4 häfte 3/4-spalt

A4hs2n A4 häfte 2-spalt

A5ls1n A5 lösblad 1-spalt

A5hs1n A5 häfte 1-spalt

A3ls134n A3 lösblad 1+3/4-spalt

Attribut Värde Beskrivning
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